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1 Intr oduction

1.1 What is XXE?

XMLmind XML Editor (XXE for short)is anXML editor featuringDTD-awareeditingcommandsanda
word processor-likeview configuredusingW3C’scascadingstylesheets(CSS).

Attribute editor showing current
element attributes

(like all the elements displayed in this view)

Main window displaying the beginning of

by Norman Walsh, Bob Stayton
an Jirí Kosek

a DocBook document:
DocBook XSL Stylesheet Documentation

Current element: an <ulink> styled using CSS

Cross−reference problem indicator

Current element path in the document

Clipboard can contain elements too, not only text

Current element: an <ulink> styled using CSS

Screenshotof XXEM1

XXE is acommercialproductbut for now, XXE is only availablein milestoneversions. Milestone1 is the
only versionwhich hasbeenreleasedto thepublic. Milestone1 is not abetaversionof thefutureproduct:
it is a prototypewhichhasbeencreatedto validatesomeaspectsof theproduct.

However, this prototypeis rock solid andhasenoughfeaturesto allow technicalwriters to comfortably
authorXML documents.Today, XXE M1 is routinelyusedto createDocBookandXHTML documentsas
well asdocumentsusingproprietaryDTDs almostascomplex asDocBook.

XXE M1 can be usedat no charge with a very liberal license. SeeXMLmind StandardXML Editor
License.

TheXXE productwill toohaveafreeedition(theStandardEditionasopposedto thenon-freeProfessional
Edition). So XXE M1 usersnot willing to pay to usean XML editor will not meeta deadendoncethe
productwill bereleased.
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2 Features

2.1 Features

� XXE canbeusedwith or without aCSSstylesheet.

If a CSSstylesheethasbeenattachedto thedocument,a word processor-like view maybeusedto
edit thedocument,otherwiseaeditabletreeview is used.

� A substantialsubsetof CSS2is supported,includingtables,countersandgeneratedcontent.

� UsingtheCSS2extensiondisplay: tr ee, it is possibleto mix styledandnon-styledelements.

� Usingthe replacedcontentCSS2extension,it is possibleto embedspecializededitorsin thestyled
view. Replacedcontentis alsoroutinelyusedto embedimages.

� CSSstylescontainedin @mediaprint constructsareautomaticallyappliedwhenprinting thedoc-
umentbeingedited.

� XXE canbeusedwith or without aDTD.

If theXML documenthasa DTD andis valid (conformsto thatDTD), XXE will not suggestto the
userany editingcommandsthatwould makethedocumentinvalid.

Without a DTD, theuseris allowedto do whateverhewants,for examplehecaninventelementsor
attributes.XXE justensuresthattheXML documentremainswell-formed.

� XXE canloadaninvalid XML document(thatdoesn’t conformto its DTD).

In suchcase,afterreportingall thevalidity problemsto theuser, it putsitself in repairmode(alenient
editingmode)until thedocumentstructureis fixedby theuser.

Notes:

– XXE cannotloada non-well-formeddocument.

– XXE distinguishes3 degreesof severity for theinvalidity of adocument:

1. Invalid structure(theindicatorat thebottomleft of themainwindow is red).

2. Invalid attributes(theindicatoris orange).

3. Crossreferenceproblems(theindicatoris yellow).

XXE entersin repairmodeonly whenstructuralproblemsarefound.

– XXE will probablyhave a very nastybehavior if theDTD is itself invalid. Thevalidity of the
DTD is never checkedby XXE (plannedfor futureproduct). It mustbecheckedoncefor all,
prior to beusedwithin XXE, with a separatetool suchdtdvalid which is partof theXsdvalid
Toolset.

� Multi-level undo/redo.

� Literal andregularexpressionsearchandreplace.

� Spellcheckerwith dictionariesfor severallanguages.

� Out of thebox, XXE hasreadyto usesupportfor XHTML, DocBook,SimplifiedDocBook,Slides
andJavadoc(TM).

� XXE shouldrun on any platform supportingJava 1.3 andabove. XXE is officially supportedon
Linux, WindowsNT/2000/XPandMacOSX.

� XXE M1 distribution includesthefull sourcecodeof theprototype.
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2.2 Non features

This M1 releaseis just a prototypeand therefore,someimportantfunctionalitieshave not beenimple-
mented.Herearesomeaspectsof XXE M1 which maypreventyou from usingthis version:

� XXE M1 is heavily documentoriented.It is not veryusefulfor editingXML databecause:

– It cannotbeusedto edit commentsandprocessinginstructions(plannedfor futureproduct).

– It doesn’t understandnamespaces(plannedfor futureproduct).

– It doesn’t understandXML-Schemas(plannedfor future product: a preview of its XML-
Schemavalidationenginecanbedownloadedfrom http://www.xmlmind.com/xsdvalid.html)

– Elementattributesareeditedusinga secondarywindow andyou areforcedto switchbackand
forth from themaindocumentwindow to theattributeeditor, which is rathertedious.

� Theeditingcommandsof XXE M1 areXML elementorientedandtherefore,prettylow-level for the
averageuser(whomayhavehardtimestrying to think in termsof XML elements).

� XXE cannotbeusedto edit thephysicalstructureof anXML document(entities,CDATA sections,
markedsections,etc).

A well-formedXML documentmakinguseof thesefeaturescanof coursebeloadedinto XXE but
assoonasthedocumentis loaded,theseconstructsareexpandedandforgotten.

� XXE loadsthewholedocumentin memoryin orderto beableto edit it. Therefore,youneeda lot of
RAM anda fastCPUif you intendto edit largedocuments.
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3 Install

3.1 Installing XXE

3.1.1 Requirements

� Sunor IBM Java 1.3or above.

� At least128Mbof memoryanda 400MHzCPU.

� 20Mb of freedisk spacefor a binarydistribution, 25Mb for a sourcedistribution, 50Mb for a self-
containeddistributionwhich includesa Javaruntime.

Note that someJava runtimesmay be very slow and/or havevery severe bugs. So if you experiment
extremeslownessor weird behaviors (especiallythoserelatedto the GUI) with XXE, do not hesitateto
upgradeyourJava runtime.

XXE hasbeentestedwith:

� SunJava 1.3.1and1.4underSuSELinux 7.2.

� SunJava 1.3.0_02underWindowsNT SP5.

� MacJava1.3.1underMacOSX 10.1.

3.1.2 Install on Unix

Procedure:

1. UnpacktheXXE distributionsomewhere.

$ cd
$ gzip -d -c xxe-m13p2-bin.tgz | tar xvf -
$ ls xxe-m13p2-bin
aptparser.jar
css/
dict/
docs/
dtd/
azcheck.jar
jaxp.jar
regexp.jar
sax2.jar
xp.jar
template/
xxe
xxe.bat
xxe.jar
...

2. XXE canbedirectlyusedfrom thexxe-m13p2-bin/directory.

If for somereasons,you do not want to useXXE from its distribution directory, copy thexxe shell
script,*.jar andthedict/ subdirectoryto adirectoryreferencedin yourpath(example/usr/local/bin).
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$ su
$ cp ~/xxe-m13p2-bin/xxe /usr/local/bin
$ cp ~/xxe-m13p2-bin/*.jar /usr/local/bin
$ cp -r ~/xxe-m13p2-bin/dict /usr/local/bin
$ chmod a+rx /usr/local/bin/xxe
$ chmod a+r /usr/local/bin/*.jar
$ chmod a+rwx /usr/local/bin/dict
$ chmod a+r /usr/local/bin/dict/*

3.1.3 Manual install on Windows

Manualinstall on Windows NT is similar to the install on Unix but underWindows you’ll have to copy
xxe.bat ratherthanthexxe shellscript.

You’ll alsohave to manuallyedit this .batfile andmodify theline:

set dist=D:\src\xmledit\distrib

by replacingD:\src\xmledit\distrib by thenameof theactualdirectorycontainingthexxe.bat and
all the.jar files.

3.2 Content of the distrib/ dir ectory

docs/ Containsthis userguidein HTML andPDF(Acrobat)formats.

TheDocBook(userguide.xml) andXHTML (userguide.xhtml) versionsareprovidedtoo be-
causeit maybeusefulto loadtheminto XXE in orderto evaluatetheeditor.

dict/ Containsthedictionariesusedby thespell-checker. A dictionaryis aJarfile whosenameis LL.jar,
whereLL is anISOcodefor a language.

Dictionariesdownloadedfrom theXMLmind Websitemustbecopiedto this subdirectory.

dtd/ Contains3 DTDs (DocumentTypeDefinition):

� docbook/is theofficial DocBookXML DTD V4.1.2.

Seehttp://www.oasis-open.org/docbook/xml/.

Modifications:

– Definedthexml:spaceattributeas:
xml:space (default|preserve) #FIXED ’preserve’

for the following elements:address,funcsynopsisinfo,literallayout,programlisting,pro-
gramlistingco,screen,screenco,synopsis.

– Reorderedsomedefinitionsin theDTD to have moreusefulnewly insertedelementtem-
plates.

Element Old order New order
table
informaltable

(graphic+|mediaobject+
|tgroup+)

(tgroup+|graphic+
|mediaobject+)

� sdocbook/is NormanWalsh’s SimplifiedDocBookXML DTD V4.1.2.5.

Seehttp://www.oasis-open.org/docbook/xml/simple/.

Modifications: sameasfor docbook.
� slides/is NormanWalsh’s SlidesXML V2.0 DTD.

Seehttp://sourceforge.net/projects/docbook/.

Modifications: sameasfor docbook.
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� xhtml/ is theXHTML 1.0DTD.

Seehttp://www.w3.org/TR/xhtml1/.

Modifications:

– Fixedthedefinitionof xml:spacefor elementpre.Thebuggydefinitionwas:
xml:space (preserve) #FIXED ’preserve’

– Reorderedsomedefinitionsin theDTD to have moreusefulnewly insertedelementtem-
plates.

Element Old order Neworder
table ... (tbody+|tr+) ... (tr+|tbody+)
tr (th|td)+ (td|th)+

css/ Contains2 CSSstylesheets:

� xhtml.css,a stylesheetfor XHTML 1.0.
� docbook.css,a tentativestylesheetfor DocBookV4 (simplifiedor not).

template/ Contains4 documenttemplates:

� html.xhtmlcanbeusedto createanXHTML page.
� chapter.docbis a DocBookchaptertemplate.
� article.docbis a DocBookarticletemplate.
� article.sdocbis a simplifiedDocBook(muchfasterto loadthanfull DocBook)articletemplate.

xxe,xxe.bat Scriptsusedto startXXE. (Usexxeon any Unix system.Usexxe.baton WindowsNT.)

*.jar All the(non-system)Javaclasslibrariesneededto run XXE:

� xxe.jar, containsthecodeof XXE.
� aptparser.jar, containsthecodeof theAPT parser.

This codeis requiredonly if youusetheAPT formatplug-in for XXE. (This is ourcasehereat
Pixwarebecauseall theXXE documentationis written in APT.)

� jaxp.jar, sax2.jar, xp.jarareneededto parseXML.

Theseexcellentpackageshave not beendevelopedby XMLmind. Copyright information is
containedin the corresponding.LICENSE file. Readthe corresponding.README file to have
moredetailsaboutthesepackages.

� regexp.jarcontainsanimplementationof regularexpressionsfor Java.

This excellentpackagehasnot beendevelopedby XMLmind. Copyright informationis con-
tainedin thecorresponding.LICENSE file. Readthecorresponding.README file to havemore
detailsaboutthis package.

� azcheck.jaris a betaversionof AZcheck,a not-yet-releasedpureJavaspell-checker.

Copyright informationis containedin thecorresponding.LICENSE file. Readthecorrespond-
ing .README file to havemoredetailsaboutthis product.

3.3 Deploying XXE

� The dtd/, css/,andtemplate/directoriesare intendedto be shared.So it is recommendedto copy
themin adirectorywhich is accessibleusinganHTTPserver.

It is importantto do sobecauseall documentssavedby XXE containabsolutefile or http URLs to
theirDTD andstylesheet.
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� Add yourown DTDs,CSSstylesheets,andXML documenttemplatesto this sharedrepository.

� Tell theXXE usersto gettheirdocumenttemplatesfrom this sharedrepositoryusingtheFile->New
menucommand(in thefollowingfigure,thesharedrepositoryishttp://localhost/~hussein/xmlshare/):

Thedialog boxdisplayedby theFile->New menucommand

All XXE optionsanduserpreferencesarepersistent(storedin file ~/.xxe underUnix andin file
C:\winnt\Profiles\<user>\xxe.ini underWindowsNT) sospecifyingthelocationof adoc-
umenttemplateis doneoncefor all.

3.3.1 Creatingnew documenttemplates

A documenttemplateis simply analmostemptydocumentcontaining:

<?xml version=’1.0’ encoding=’UTF-8’?>
<?xml-stylesheet type="text/css" href="../css/xhtml.css"?>
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
"../dtd/xhtml/xhtml1-strict.dtd">
<html xmlns="http://www.w3.org/1999/xhtml">

<head><title></title></head>
<body><p></p></body>

</html>

1. TheXML declaration(line 1).

2. Thexml-stylesheetProcessingInstruction(PI) usedto associatea stylesheetto anXML document.
(line 2).

This PI is specifiedin the W3C recommendation:AssociatingStyleSheetswith XML documents
(http://www.w3.org/TR/xml-stylesheet/).

Usingseveralof thesePIs,it is possibleto associatealternatestylesheetsto anXML document,each
onehaving its own descriptive title. Example:

<?xml-stylesheet href="bigfonts.css" type="text/css" alternate="yes"
title="Big fonts" ?>
<?xml-stylesheet href="colorful.css" type="text/css" alternate="yes"
title="Important things in red" ?>
<?xml-stylesheet href="normal.css" type="text/css" ?>
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3. Thedocumenttypedeclaration(lines3-4,notethattherootelementis specifiedto behtml).

4. Theskeletonof theroot elementspecifiedin thedocumenttypedeclaration(line 5 to end).

Thisskeletonmustcontaina valid content.

Suchtemplatemustbe createdusinga text editor. After creatingit, validateits contentby loadingit in
XXE asanexisting document(i.e. usingtheFile->Openmenucommand).
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4 Tutorial

4.1 Starting XXE

� On Unix, XXE canbestartedby typing xxe from anxterm,optionally followedby thenameof an
XML document.

Example:

$ xxe &

� If youhave installedanauto-installableWindowsdistribution (setup.exe), XXE canbestartedby
double-clickingon theicon of XMLmind_XML_Editor.exe or by usingtheXXE shortcutaddedto
theStart menu.

� If you have installeda zippedWindowsdistribution, XXE canbestartedby typing xxe (xxe.bat)
from thecommandprompt,optionallyfollowedby thenameof anXML document.

Example:

C> xxe C:\xxe\docs\userguide.xml

Tips:

� If you do not wantto readthis tutorial (definitelynot recommended:-) andjust wantto startexperi-
mentingwith XXE, youcanloadthefull userguide(a50+pagesdocumentwith 50+screendumps)
into XXE.

You’ll find it in file
<distrib>/docs/userguide.xml (DocBookformat)
andin file
<distrib>/docs/userguide.xhml (XHTML format),
where<distrib> is thelocationof yourXXE distribution.

Theslownessof loadingtheXXE userguidecomesfrom thefactthat:

1. all thescreendumpsareconvertedto 400x200“thumbnails”(explainedbelow in this tutorial);

2. the DocBookDTD is huge(that’s why the SimplifiedDocBookXML DTD hasbeencreated
by NormanWalsh).
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4.2 Creating a new document

A new documentis simply a copy of an existing documenttemplatechosenusingthe File->New dialog
box:

TheFile->New dialog box,thefirst timeXXEis started,maycontainno documenttemplates

Click on the icon at the top right of the dialog box andselectthepage.html templatecontainedin the
template sub-directoryof your XXE distribution. (In the following figure, the distribution directoryis
/home/hussein/src/xmledit/distrib):

Notethat thefile: prefix hasbeenautomaticallyprependedto thefile nameselectedusingthestandard
file chooserdialogbox. It is alsopossible(andevenrecommended)to specifytemplateshostedby a Web
server. In which case,you’ll needto enterthefull URL of thetemplateincludingthehttp:// prefix.

Userpreferencesarepersistent(storedin ~/.xxe onUnix andin C:\winnt\Profiles\<user>\xxe.ini
on Windows),soaddingtemplatesto theFile->New dialogbox is doneoncefor all.

Tips:

� An alternateway to createanew documentis to usetheFile->OpenAsTemplatemenucommand.
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Thiscommandautomaticallycreatesa“empty” documentby copying theDTD, stylesheetsandroot
element(just its attributes,not its content)from thechosendocument.

Example:Usethis commandto selecttheuserguide.xhtml file containedin thedocs subdirec-
tory of yourXXE distribution.
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4.3 Inserting elements

Thenewly createddocument(Untitled.xhtml) lookslike this:

The “blobs” areplaceholdersfor text. Click on the first placeholderandtype the title of your XHTML
page.Click on thesecondplaceholderandtypea few words.

Click againanywhereon thetitle andthenanywherein thefirst paragraph.You’ll noticethat,at thetop of
thewindow, sometool bariconschangetheir statefrom disabled(grayed)to enabled(colored)

andat thebottomof thewindow, theselectedelementpathtool changesits label.

The pathtool shows preciselywhich elementis currentlyselected,i.e. the documentobjectyou canact
uponusingtheEdit menucommands(or their tool bariconequivalent).

Thepathtool doessoby showing thetypename(p, title , etc)of theselectedelementandthetypenameof
eachof its “ancestors”in thecontainmenthierarchy(body, head, html , etc).

In this section,we’ll getfamiliarwith only threeEdit menucommands:

1. Insertbeforeselectedelement

2. Insertinsideselectedelement,at text cursorlocation

3. Insertafterselectedelement
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Click anywhereinsidetheparagraphandclick on theInsertbeforeicon. A dialogboxshowsup, listing all
theelementtypesyou caninsertbeforea p (theelementtypename,alsocalledthe tag, of a paragraphis
calledp in XHTML).

Thetag chooserdialog box

Selecttagh1 andtypethetext of theheading.

Click insidethep beforea word andclick on theInsertinsideicon, thesametagchooserdialogpopsup
listing all theinline elementsyoucaninsertinsideap. Selecttagstrongandtypeafew wordsin boldfont.

Yourdocumentshouldlook like this:
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This time, usethe Insertafter icon andadda ul (unorderedlist) after thep. Type the text of thefirst list
item(li ).

(If you are in the strong element-- checkit with the path tool -- click in the p outsidethe bold words
becauseinsertinganul insidea p aftera strong is not allowedby theXHTML DTD.)

Usingwhatyouhave learned,addtwo morelis: onebeforethefirst li youhavecreated,thesecondafterit.

Tips:

� Thekeyboardshortcutsfor thethreeinsertcommands,Ctrl-H, Ctrl-I, Ctrl-J, areeasyto remember:
I is for Insert,H is beforeI , J is afterI .

� The tag chooserdialoghasa tag auto-completionfeatureà la emacs:type the first charactersof a
tag, thentypea space, to list all theallowed tagsbeginningwith thesecharacters.Repeatuntil the
tagyou intendto insertis completelydisplayedin thetext field at thetopof thedialog.

� TheInsertkey maybeusedto inserta placeholderfor text (called#PCDATA, seebelow) after the
selectedelement(if suchinsertionis allowed).

Shift-Insertinsertsa placeholderfor text beforetheselectedelement(if suchinsertionis allowed).

Ctrl-Insertinsertsaftertheselectedelementanelementof thesametype(if suchinsertionis allowed).

Ctrl-Shift-Insertinsertsbeforetheselectedelementanelementof thesametype(if suchinsertionis
allowed).
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4.4 Selectingelements

4.4.1 Elementand #PCDATA selection

TheSelectParentandSelectChild tool bar icons

Clicking on sometext movesthetext cursor(AKA caret)to themouseclick locationandimplicitly selects
theelementcontainingthepieceof text.

It is alsopossibleto explicitly selectelements.

Click on the first p outsidethe strong andthenclick on the SelectParenttool bar icon (or type Ctrl-Up
arrow).

Explicitly selectedobjectsaresurroundedby aredline.

Thepathtool indicatesthat#PCDATA is selected.#PCDATA is not anelementtypename,it is usedto
specifyananonymouspieceof text containedin someelementslikep.

Click on thestrong elementandtypeCtrl-Up aslong astheselectedobjectchangesandobserve what is
displayedby thepathtool: first the#PCDATA containedin thestrong is selected,thenthestrong itself,
thenthep, thenthebody containingthep andfinally html itself.

Click on the SelectChild tool bar icon (or type Ctrl-Down arrow) aslong asthe selectedobjectchanges
andobservewhatis displayedby thepathtool.

Selectingobjectsby directly clicking on themis possibletoo. Therearetwo waysto do so:

1. Click in thepathtool on theelementtypenameyou wantto select.

Example:try to click in thepathtool on theword body.

2. Ctrl-click-1 onsometext alwaysselectsthecorresponding#PCDATA, whichis rarelywhatyouwant
to do. Ctrl-click-1 on themargin or on anything not editable(suchasthebullet of a li ) surrounding
anelementgenerallyselectsthis element.

Example1: Ctrl-click-1 on the text of the title. ThenCtrl-click-1 on the left or right margin sur-
roundingthetext of thetitle. Noticethedifference.

Example2: Ctrl-click-1 on the text of a li . Then Ctrl-click-1 on the bullet of the li . Notice the
difference.

NotethatIf youdonotclick neartext (for instance,if youclick onanimageor ongeneratedcontent),
youdon’t needto hold theCtrl key pressedwhile clicking. In suchcase,thereis noambiguityanda
plainmouseclick is sufficient.
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4.4.2 Text selection

Thecustomarytext selectionfoundin all word processorsis alsoavailablein XXE.

Click in themiddleof thetitle anddragthemouseacrossthedocumentuntil themiddleof thesecondli is
reached.

Notethatthepathtool displayshtml.head.title.#PCDATA, theplacewherethetext selectionbegins.

Clicking on sometext or usingtheEscapekey cancelstheexplicit selectionwhatever its nature.

In summary, youcanuse3 differenttypesof selection:

1. Theimplicit text containerelementselection.

2. Theexplicit #PCDATA or elementselection.

3. Thetext selection.

All thesetypesof selectiondiffer by thetypeof editingcommandsyou canapplyto them.Only onetype
of selectionis possibleat a time.

Tips:

� Ctrl-click in the pathtool on an elementtype nameselectsthe correspondingelementandinserts
aftertheselectedelementanelementof thesametype(if suchinsertionis allowed).

Shift-click in the pathtool on an elementtypenameselectsthe correspondingelementandinserts
beforetheselectedelementanelementof thesametype(if suchinsertionis allowed).

� The tool bar alsocontainsicons that canbe usedselectthe preceedingsibling and the following
siblingof theselectedelement.

Thekeyboardshortcutsfor thesecommandsareShift-Ctrl-UpandShift-Ctrl-Down.

� All themouseandkeyboardactionsrelatedto thetext selectionandfoundin mostword processors
arealsoavailablein XXE.

Example:UsingtheShift-Rightarrow key extendsthetext selectionto thenext character.

All theseactionsarelistedin APPENDIXC: Keyboardshortcuts.
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4.5 Navigating through elements

TheTabkey maybeusedto move thecaretfrom thecurrent#PCDATA to thebeginningof thenext one.
Shift-Tabmovesthecaretfrom thecurrent#PCDATA to thebeginningof thepreviousone.

Click on thetitle anduseTabandShift-Tabto movethecaretfrom one#PCDATA to theother.

Insideanelementwhich allows tabcharactersto beinsertedin thetext flow just asany ordinarycharacter
(example:anXHTML pre), youmustuseCtrl-TabandShift-Ctrl-Tabinstead.

Thesimplestway to movethecaretis of courseto usetheLeft or Right arrow keys.

Click on thefirst p to theleft of thestrong andtypeon theRight key to move thecaretin thedirectionof
thestrong.

Justbeforereachingthestrongelement,you’ll noticethattypingontheRightkey hascausednoperceptible
caretmovement.Thenafterthis “dead”Right key, thecaretseemsto moveasexpected.

Gobackto theleft usingtheLeft arrow andat thep/strongboundary, you’ll noticea “dead”Left key then
thecaretseemsto moveasexpected.

Thisis notabug. Onthep/strongboundary, thecaretmakesnovisiblemovementbut thepathtool displays
differentimplicitly selectedelements(p andstrong).

UsemenucommandStyle->NoStyleSheetto view thedocumentusinga low-level hierarchicalview.

In thisfigure, for more compactness,thehead, h1, andul elementshavebeencollapsedbyclicking on the
arrow locatedat theleft of each elementtypename

Repeatwhatyou have donewith theRight andLeft arrow keys andyou’ll noticethatwith the treeview,
thereisavisiblecaretmovementfromtheendof thep.#PCDATA to thebeginningof thestrong.#PCDATA
andvice-versa.

Switchbackto thestyledview usingtheStyle->xhtmlcommand(xhtml is thenameof theCSSstylesheet
usedby thedocumenttemplate).

This “dead” key behavior alsooccurswhenusingtheDel andBackspacekeys.

Click on thefirst p to theleft of thestrongandtypeon theDel key. Noticewhathappenson thep/strong
boundary. ThenuseEdit->Undo(Ctrl-Z) to undothis typing.
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Click insidethe strong andtypeon the Backspacekey. Notice what happenson the p/strong boundary.
ThenuseEdit->Undoto undothis typing.

Tips:

� TheUp andDown arrow keysmaybeusedto movethecaretfrom oneline to theother. But because
theinternalsof XXE arenot line-based,caretmovementsmayoccasionallybesurprising(generally
insidetables).

� All thekeyboardactionsrelatedto thecaretmovementandfoundin mostword processorsarealso
availablein XXE.

Example:UsingtheCtrl-Rightarrow key movesthecaretto thebeginningof thenext word.

All theseactionsarelistedin APPENDIXC: Keyboardshortcuts.

� If sometimesyou do not understandXXE behavior, try to switch to the treeview usingthe Style-
>NoStyleSheetmenucommand.Usingthislow-levelhierarchicalview, thingstendto bemucheasier
to understand.

Notethateverythingsaidin this tutorial alsoappliesto thetreeview.

Despitethefact that, for theuser, this view looks fundamentallydifferentfrom thestyledview, for
XXE, theseviews arenot differentat all (becauseXXE doesnot work at the view level but at the
documentelementslevel).

� In atreeview, Click with theright buttonof themouseonthearrow locatedattheleft of eachelement
typenameto popup a contextualmenuwith ExpandAllandCollapseAllcommands.
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4.6 Copy, cut, paste,delete

TheCut,Copy, Pastebefore, Paste, Pasteafter, Deletetool bar icons

4.6.1 Text selection

Whenappliedto thetext selection,theEdit->Copy menucommandcopiesall theselectedcharactersto the
systemclipboard.It is thenpossibleto pastethesecharactersin any otherapplicationincludingXXE itself.

Selectthecharactersdisplayedin boldfont from thefirst p, copy themto theclipboardusingtheCopy tool
baricon,click on thetitle andpastethecopiedcharactersusingthePastetool baricon.

After copying the text selection,you’ll noticethat the clipboard tool at the bottomof theXXE windows
displays#PCDATA: apieceof text is storedin theclipboard.

Edit->CutandEdit->Deletebasicallywork thesameway: they deleteall theselectedcharactersfrom the
document.Theonly differenceis thatEdit->Cutcopiesthedeletedcharactersto theclipboard.

Note that thesecommandsalso eagerly deleteemptytext containerelementscontainedin a parenttext
containerelement.

Click in themiddleof thetitle anddragthemouseacrossthedocumentuntil themiddleof thesecondli is
reached.Thenclick of theDeletetool baricon.
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Thestrongelementin thefirst p hasbeendeletedbecauseit wasanemptytext containerelementcontained
in a text containerelement.

Theh1, p, li , while beingemptytext containerelements,havenotbeendeletedbecausethey arecontained
in a nontext containerelement(body, ul).

UseEdit->Undo(Ctrl-Z) to undothiscommand.

4.6.2 Elementand #PCDATA selection

TheCopy, Cut,Paste,Deletecommandscanoperateon theselectedelement(whetherimplicitly or explic-
itly selected)or #PCDATA too.

For this typeof selection,two morecommandsareavailable:PastebeforeandPasteafter.

Selectthefirst li . UsetheCut tool bariconto moveit to theclipboard.Selectthelast li . UsethePasteafter
tool baricon to pastethe li storedin theclipboardafterthelast li .

After copying thefirst li , you’ll noticethat theclipboardtool at thebottomof theXXE windows displays
li : a list itemelementis storedin theclipboard.

Tips:
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� The Del key may be usedto deletethe text selectionbut for the elementor #PCDATA selection,
you’ll haveto typeCtrl-K (K likeK ill).

(With theelementor #PCDATA selection,typingon theDel key just deletesthenext character.)

� The keyboardshortcutsfor the Copy, Cut, Pastecommandsare thoseusedin most applications:
Ctrl-C, Ctrl-X, Ctrl-V.

Thekeyboardshortcutsfor thePastebeforeandPasteafter, Ctrl-U andCtrl-W, areeasyto remember:
U is beforeV andW is afterV.

� Cuttingandpastingelementsbetweentwo instancesof theXXE applicationis possible.

� Whentheclipboardis filled by anexternalapplication,thenew clipboardcontentdoesnot automat-
ically appearin theclipboardtool at thebottomof theXXE window.

You’ll needto manually“refresh”thetoolbarandstatusbarin orderto seethenew clipboardcontent.
For example,click on anotherelementto implicitly selectit. This way, theeditingcontext changes
andthetool barandstatusbarneedto berefreshed.
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4.7 Splitting and joining elements

TheSplit andJoin tool bar icons

TheEdit->Split commandmaybe usedto split the selectedtext containerelementin two, the split point
beingspecifiedby thecaretposition.This commandwill not operateonany otherselectedobject.

Click in themiddleof thestrong containedin thefirst p. UsetheSplit tool bar icon to split thestrong in
two. Nothingvisiblehappens.

Thereis no bug here.Switchto thetreeview usingStyle->NoStyleSheetto seewhatreally happened.

Two adjacentstrong elementshave beencreatedand the boundarybetweenthesetwo elementsis not
visibleusingthestyleview.

UseEdit->Undo(Ctrl-Z) to undothesplit andswitchbackto thestyledview usingStyle->xhtml.

Click in themiddleof thestrongcontainedin thefirst p. UseCtrl-Up to explicitly selectthep.
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TypeCtrl-Enter(thekeyboardshortcutfor Edit->Split) to split thep containingthestrong in two.

TheEdit->Join(keyboardshortcutCtrl-Backspace)is theinversecommandof Edit->Split. It concatenates
theselectedelementwith thepreceedingone,if thispreceedingelementis of thesametype(i.e. youcannot
join a p with apre).

Whentwo elementsare joined, if the first child elementof the selectedelementandthe last child of its
preceedingelementcanbejoined,they arejoinedtoo. And thishappensatall nestinglevelsto reallymake
Edit->Jointheinversecommandof Edit->Split.

Selectthep createdby thesplit commanddescribedabove, for exampleby clicking on it andthenusing
theselectedelementpathtool.



XMLmindXML Editor M1.3User’sGuide 26

TypeCtrl-backspaceto join thisp to thepreviousone,thenundothecommandby typingCtrl-Z.

Tips:

� If you want to inserta new paragraphafter anotherparagraph,click nearthe endof the paragraph
(thecaretis thenpositionedafterthelastcharacterof theparagraph),thentypeCtrl-Enter.

� Whenthereis no ambiguity, typing Enter(ratherthanCtrl-Enter)splits theselectedelementin two
parts.

Example:typing EnterwhenanXHTML p is theselectedelement,splits thep in two parts,while
typingEnterwhenanXHTML pre is theselectedelement,insertsa linefeedcharacterinto thepre.
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4.8 Replacingelements

TheReplacetool bar icon

The Edit->Replacecommandis equivalentto deletingthe selectedelementor #PCDATA andinsertinga
new elementor #PCDATA which replacesthedeletedelement.

This commandis requiredbecauseit is oftennot allowed to deletetheselectedelement:doingsowould
createaninvalid document.

Selecttheul. Inserta table afterit.

The tableis createdwith a singletr (row) containinga singletd (cell). This is oftenwhatyou wantasa
table templatebut not always.

Selectthetr . UsetheReplacetool baricon to replaceit with a tbody.
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As anexercise,selectthe td containedin the tr containedin the tbody andreplacewith a th (anothertype
of cell). Thenaddonemorerow. Eachrow mustcontaina th followedby a td.
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Tips:

� Note that besidetbody, the tag chooserdialog alsosuggeststo replacea tr with anothertr . This
behavior is usefulto replaceafilled elementwith anemptyoneof thesametype.
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4.9 Converting elements

TheConvert tool bar icon

4.9.1 Text selection

Whenappliedto thetext selection,theEdit->Convertcommand

1. deletesall theselectedcharacters(like Edit->Cutor Edit->Delete,it alsoeagerlydeletesemptytext
containerelementscontainedin a parenttext containerelement);

2. putsall thedeletedcharactersin thechosenelementor #PCDATA (thetargetof theconversion);

3. insertsthis newly createdtext containerat thelocationwherethetext selectionstarts.

As a simpleexample,selecta non-boldword in thefirst p.

UsetheConvert tool baricon to convert it to em (emphasis).

As a harderto understandexample,selectsometext from themiddleof thestrong in thesecondp to the
endof thisp.

UsetheConvert tool bar icon to convert thetext selectionto strong. But thereis a trick here:becausethe
text selectionstartsin thestrong, you mustspecify#PCDATA whenpromptedby thetagchooserdialog.

Note that the tag chooserdialogproposesstrong asa valid choice,becausein XHTML, it is possibleto
haveastrongcontainedin a strong.
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4.9.2 Elementand #PCDATA selection

Convertinga#PCDATA ratherthananequivalenttext selectionis oftenmoreconvenient.

Selectthe#PCDATA containedin thesecondcell of thetable.

TypeCtrl-T (thekeyboardshortcutof Edit->Convert,T is for Translate)to convert it to em.

Unlike Edit->Replacewhich createsemptyelements,theEdit->Convertcommandtransfersthecontentof
thesourceelement(but not its attributes)to thetargetconvertedelement.

Selecttheul.

TypeCtrl-T to convert it to anol (orderedlist).

This operationis valid becausetheul parent,a body, acceptsuls aswell asols at this placeandbecause
theelementcontentof this ul is “compatible”with anol.
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4.10 Editing elementattrib utes

UseTools->EditAttributes(keyboardshortcutCtrl-E) to edit theattributesof theselectedelement.

TheAttributeEditor dialog boxwith therowspan attributeof a td beingedited

Thisdialogboxcanbequickly describedasfollows:

� Thedialogbox is nonmodal.You cankeepit openall thetime. Its contentwill reflecttheattributes
of theselectedelement(whetherexplicitly or implicitly selected).

� All possibleattributesfor anelementarelistedin alphabeticalorderwith theirdefaultvalue(if any).

Attributeswhichhavenotbeensetaredisplayedin gray. Attributeswhichhavebeensetaredisplayed
in black.

� Requiredattributenamesaredisplayedusinga bold font. Fixedattributenamesaredisplayedusing
anitalic font.
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� Thefield on theright of theattributenameis editable:click on it andtypethevalueof theattribute.

If the attribute type is enumerated,this field is a menuratherthana text field, so you candirectly
choosethevalueof theattributewithout having to type.

� Undertheattributename/valuetable,a small form canbeusedasanalternateway to edit thevalue
of anattribute.

Practically, you’ll never usethis form except for the “minus” button which is usedto remove an
attribute.

This form is mainly useful

– for documentswithout aDTD whereyou needto createattributes(i.e. entertheir names);

– whentheattributetype is complicated(ex. ENTITIES) andyou needtheassistanceof oneof
thespecializededitorspoppedupwhenyouclick onthe“list” buttonat theright of theattribute
valuetext field.

Thisdialog boxmaybeusedto specifya list of ENTITIES

Type Ctrl-E to pop up the attribute editor. Selecta td in the table. Set its align attribute to center,
its rowspan attribute to 2, its valign attribute to middle. Add an extra td to make the table look more
balanced.



XMLmindXML Editor M1.3User’sGuide 34

It is importantto rememberthat XXE automaticallygivesa dumbvalueto requiredattributesof newly
createdelements(otherwisethe documentwould be invalid). This meansthat you have to replacethis
dumbvalueby theactualoneassoonastheelementhasbeencreated.

Add ap afterthetable andinsertan img in it.

The img hastwo requiredattributessrc andalt. XXE hassetthoseattributesto string’?’.

Usetheattributeeditorto give theseattributesanactualvalue.

(In this figure,we usedfile:/usr/local/httpd/icons/apache_pb.gif for src andPowered by

Apache for alt.)

Notesabout images:

� UsingtheCSSstylesheetsincludedin theXXE distribution, imagesaresystematicallydisplayedas
400x200“thumbnails”.

If you don’t like this behavior, you’ll have to changethestylesheetsby commentingout thecorre-
spondingcontentproperty.

� XXE candisplayimagesin theGIF, JPEGandPNG(JDK1.3)formats.Thisshouldnot preventyou
from specifyingimagesin otherformats: theseimageswill bedisplayedusingthe standardimage
placeholdericon.
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4.11 Checkingdocumentvalidity

Youcannotcheckthevalidity of a documentwithoutanassociatedDTD. (Wheneditinga documentwith-
outaDTD, XXE guaranteesthatwhatyou’ll createwill bewell-formedwithoutmakingany specialeffort.)

This section,like mostof this tutorial, describesthe behavior of XXE whenediting documentswith an
associatedDTD.

Checking documentvalidity is automaticallyperformedeach timeyousaveyourdocument.

Unlessthe DTD is ill-formed, XXE will never allow editing commandsthat would make the document
structurally invalid (adocumentwheresomeelementshave invalid sub-elementsor attributenames).

Thereforeexplicitly checkingdocumentvalidity is rarelyneeded.YoumayhavetousetheTools->CheckValidity
commandwhen:

1. You have loadedaninvalid documentandyou arefixing it. After eacheditingcommand,you want
to know if it is fixednow.

2. XXE createselementswherethevalueof theattributeis invalid.

This almostalwaysoccurswith an elementwhich hasan attribute of type IDREF (a referenceto
anotherelementidentifiedby a uniqueID).

It is possibleto createthis typeof elementbeforecreatingany elementidentifiedby a uniqueID.

In suchcase,XXE cannotautomaticallygiveto theIDREFattributeavalid value,andfor thisreason,
yourdocumentis temporarilyinvalid.

After explicitly or implicitly checkingdocumentvalidity, its validity statusis displayedat thebottomleft
of thewindow usingthesameiconbut with threedifferentcolors.

Icon color Meaning
No icon atall Documentis valid
Yellow Cross-referenceproblems

(ex. anIDREF attributecontainsa reference
to a non-existentID)

Orange Invalid attributenamesor values
(otherthancross-referenceproblems)

Red Invalid elementcontent

Whenthevalidity statuschangesfrom any color to red,XXE changesits editingmodefrom normal(strict)
to repair(lenient).It will alwayssignalthis transitionby poppingup a dialogbox.
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In repairmode,in order to fix an invalid document,you areallowed to insertanddeleteelementsmore
liberally thanin thenormal,strict mode.

InvokingtheTools->CheckValidity commandwill popupanon-modaldialogboxlisting all validity errors,
if sucherrorsaredetected.

Clicking onanerrornumberwill selectthecorrespondinginvalid elementandwill scroll theXXE window
to make it visible.

Tips:

� Insteadof usingtheToolsmenu,youcanclick onthevalidity icon locationin thestatusbarto invoke
theTools->CheckValidity command.
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5 Command reference

5.1 File->Print

Displaystheprint dialogboxin orderto print theexplicitly selectedelementif any, andthewholedocument
otherwise.

Preferencesrelatedto printing maybespecifiedin thePrint tabof theOptionsdialogbox.

5.2 Search->Replace

TheSearch/Replacedialog box

Thedocumentis searchedfrom caretpositionto theendof thedocument.

If replacementsareto beperformedalongwith thesearchandanelementhasbeenexplicitly selected,the
search/replacestartsat thebeginningof this element,whatever is thepositionof thecaret,andendsat the
endof this element.(A backwardsearch/replacestartsat the endof the selectedelementandendsat its
beginning.)

Ignorecase Thesearchis case-insensitive. Example:"foo" matchesboth"foo" and"Foo".

Whole word The found string must be a word, that is, the found string must be surroundedby white
spaces.Example:"foo" matches"foo" but not "foobar".

Regular expression Thesearchedstringmustbeavalid regularexpression.

In suchcase,$1,$2, ..., $9 maybeusedin thereplacementstringto referto thesubstringsmatching
theparenthesizedgroupsof theregularexpression.

$0 is replacedby the string matchingthe regular expressionin its entirety. $$ may usedto quote
character’$’.

Examples:

� "f(o+)" matching"foo", replacedby "g$1", gives"goo".
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� "f(o+)" matching"foo", replacedby "$0bar",gives"foobar".
� "f(o+)" matching"foo", replacedby "g$$1",gives"g$1".

Backwardregularexpressionsearch/replacemaybeslow to thepoint of beingunusable.

Preferencesrelatedto searchingmaybespecifiedin theSearchtabof theOptionsdialogbox.

5.3 Tools->CheckSpellingErrors

TheSpellChecker dialog box

Tools->CheckSpellingErrors(keyboardshortcutCtrl-Shift-S) checksthe text of the documentfrom the
word containingthecaretto theendof thedocument.

If anelementhasbeenexplicitly selected,thespellcheckerstartsatthebeginningof thiselement,whatever
is thelocationof thecaret,andstopsat theendof theelement.

Notethatif thepartof thedocumentto becheckedcontainsno spellingerrorsthedialogboxshown above
is not displayedat all. Insteadmessage"Foundno spellingerrors" is displayedat the bottomof XXE
window.

"W ord:" text field This text field displaystheword for which thespellcheckerhasfoundanerror.

This text field canalsobeusedto modify this word. After editingtheword, typing on theEnterkey
replacestheoriginalwordby themodifiedone.

"Suggestions:" list This list containsreplacementwords,if any, suggestedby thespellchecker.
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"Language:" combobox This combobox maybeusedto selectthe languageof thedictionaryusedby
thespellchecker.

It is possibleto switch from a languageto anotherat any time. In suchcase,the spell checker is
automaticallyrestartedwith theotherdictionary, beginningat theword displayedin thetext field.

Thelastselectedlanguageis recordedin theuserpreferencefile in orderto beautomaticallychosen
in subsequentXXE sessions.

Notethat,in this milestoneversion,thespellchecker ignoresxml:langandlangattributesandthatit
cannotbeconfiguredto automaticallyskipcertaintypesof elements.

"Replace" button Replacestheoriginalword by thecontentof thetext field.

An emptytext field maybeusedto deletetheoriginalword.

"Replace All" button Replacesall occurrencesof theoriginalwordby thecontentof thetext field.

Thisbuttonis disabledfor errorsdifferentfrom "Unknown word" or "Improperlycapitalizedword".

"Ignor e" button Skipstheword for which thespellcheckerhasfoundanerror.

"Ignor eAll" button Skipsall occurrencesof theword for which thespellcheckerhasfoundanerror.

Thisbuttonis disabledfor errorsdifferentfrom "Unknown word" or "Improperlycapitalizedword".

"Lear n" button Recordstheword in thepersonaldictionaryfor currentlyselectedlanguage.

Thisbuttonis disabledfor errorsdifferentfrom "Unknown word".

Personaldictionariesaretext files nameddict_LL.txt, whereLL is an ISO codefor a language.
Thesefilesarecreatedin directory
~/.xxespell

underUnix andin directory
C:\winnt\Profiles\<user>\xxespell

underWindows.

PersonaldictionariesareautomaticallysavedwhenXXE is exited.
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5.4 Options->Options

TheOptionsdialog box

Guesswhat spacesIf this toggleis checked,whenloadinganXML file without a DTD associatedto it,
whitespacecharactersaretrimmedfrom elementscontainingchild elementsseparatedby whitespace.

Default: no.

Thisheuristicis oftena goodonefor XML-data.

Don’t usethe stylesheet Checkthis toggleif you alwayspreferto edit XML usingthe treeview rather
thantheCSSstyledview.

Default: no.
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Encoding UTF-8 is thedefaultencodingof theXML filescreatedby XXE becausethisencodingis com-
pactandmaybeusedto representall Unicodecharacters.

However, if youneedto deliveranXML file createdby XXE to apersonusingatext editorto view or
modify it, it is nicer to usea human-readableencodingsuchasISO-8859-1(Westerncharacterset).
In suchcase,checktheISO-8859-1toggle.

Default: UTF-8.

Notes:

� If you only useASCII characters,choosingeitherencodingmakesnodifference.
� If you usecharactersoutsidethe ISO-8859-1characterset,checkthe UTF-8 toggleor you’ll

have ’?’ replacingall nonISO-8859-1charactersin theXML file createdby XXE.
� Human-readableencodingsotherthanISO-8859-1(Cyrillic=ISO-8859-5,Greek=ISO-8859-7,

etc)arenot listedin thisdialogboxbecausewe cannotreadbacksuchfiles in XXE.

Indent XML filescreatedby XXE areby defaultnot indentedbecauseit is fasterandsafer(norisk to add
superfluouswhitespace)to do so.

However, if you needto deliver anXML file createdby XXE to a personusinga text editor to view
or modify it, it is nicerto providethis personwith anindentedXML file:
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whenDTD Checkthis toggleto createindentedXML files for documentsthathave a DTD associ-
atedwith them.It is alwayssafeto doso.

Default: no.

whenno DTD Checkthis toggle to createindentedXML files for documentswithout a DTD as-
sociatedwith them. It is not always safeto do so becausethis option may addsuperfluous
whitespace.

Default: no.

In indentedfiles, elementswith an emptycontentmodelaresaved as(XHTML example)<br />

ratherthan<br/> andemptyelementswith anon-emptycontentmodelaresavedas<p></p> rather
than<p/>.

This hasbeenrecommendedby theW3C to helpWebbrowsers(HTML useragentsasthey say)to
correctlydisplay XHTML. For DTDs other thanXHTML, this behavior causesno harm. It even
improvesthereadabilityof theindentedXML filescreatedby XXE.

Indentation Specifiesthenumberof spacecharactersusedto indentachild elementrelatively to its parent
element.

Default: 2.

Max. line length Specifiesthemaximumline lengthfor elementscontainingtext interspersedwith child
elements.

Default: 78.

This numberis only usedasa hint: XML files createdby XXE maycontainlinesmuchlongerthan
this number.
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Screenresolution Specifiesthescreenresolutionin DPI (Dot PerInch) usedwhenprinting. This resolu-
tion directlydeterminestheamountof text a printedpagecancontain.

Default: 100dpi.

Begin Thepageheaderhas3 areas:begin (the left for left-to-right languages),middle,end(right). This
field specifiesthetext printedat theleft of thepageheader.

Default: empty.

Eachareacancontainamix of text andvariables:

Variable Description
%F File nameof thedocumentbeingedited
%P Equivalentto "page%I of %C"; seebelow
%I Currentpagenumber
%C Totalpagecount

Middle Specifiesthetext printedat thecenterof thepageheader.

Default: empty.

End Specifiesthetext printedat theright of thepageheader.

Default: empty.
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Color Specifiesthecolor of thetext of thepageheader.

Default: gray.

Note that the font usedfor the pageheaderis the default font of the style sheet(seethe Style tab
below).

Underline [Overline] Specifiesif athin line is to beprintedbelow thepageheader[abovethepagefooter].

Default: yes.

Max. undo actions Specifiesthemaximumnumberof undo(redo)actionsa userwill beableto perform.
Limited to 100becauseasingleundoactionmayconsumea greatdealof memory.

Default: 10.

When a new elementis created... XXE in its milestoneincarnationhasno way to specifya templatefor
anewly createdelement(example:atablethathasahead,two rowsandtwo columns).Instead,XXE
recursivelycreatesthenew elementandits childrenaccordingto theminimumvalid contentspecified
by theDTD.

Thisoptionspecifieshow anew elementis recursively createdwhenthecontenttypefor this typeof
elementhasseveralpossiblechoicesfor thechild elements.
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DocBookexample:thenew elementto beinsertedis afigure.

<!ELEMENT figure ((title,titleabbrev?),(literallayout|programlisting|
programlistingco|screen|screenco|screenshot|synopsis|cmdsynopsis|
funcsynopsis|classsynopsis|fieldsynopsis|constructorsynopsis|
destructorsynopsis|methodsynopsis|address|blockquote|graphic|
graphicco|mediaobject|mediaobjectco|informalequation|informalexample|
informalfigure|informaltable|indexterm|beginpage|link|olink|ulink)+)>

Do not make a choice Insertsa figurewith atitle but no body.
With this option, thenewly createdelementmaybe invalid. Therefore,usethis option if you
reallyknow whatyouaredoing.

Usefirst choice Insertsa figurewith atitle andaliterallayout.

Make choicebaseda heuristic Insertsa figurewith atitle andalink.
The,very questionable,heuristicselectsthe text containerwith the shortestname.This is the
defaultvaluefor this option.

Text boundaries Searchingstring "Hello world!" in an XML documentis not as obvious as it seems:
for example,is "Hello world!" with word "Hello" containedin an emphasiselementfollowed by
#PCDATA " world!" supposedto befoundby XXE?
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Thisbehavior canbespecifiedby choosingoneof the3 following modes(eachmodecorrespondsto
a radiobuttonin theSearchtab):

1. Smartmode:"Hello world!" is foundwithin "<em>Hello</em>world!" but not within
"<p>Hello </p><p>world!</p>".

This modeusesthe DTD to recognizelogically contiguoustext acrossdifferenttypesof ele-
ments.

A text searchbehavesasif 2 linefeedcharactershavebeeninsertedaftereachcontiguouspiece
of text. It is thereforepossibleusingregularexpression"\n\n" to find andvisualizethesetext
boundariesin thedocument.

2. DumbmodeA: thereareno boundariesarounda #PCDATA whatever the typeof theelement
containingit.

3. DumbmodeB: a#PCDATA is separatedfrom other#PCDATA whateverthetypeof theelement
containingit.

Default: mode1.

Ignorecase Default value for checkbox Ignore caseof the Search/Replacedialog box (seeSearch-
>Replace).

Default: yes.

Whole word Default value for checkbox Whole word of the Search/Replacedialog box (seeSearch-
>Replace).

Default: no.

Regular expression Default valuefor checkbox Regular expressionof the Search/Replacedialogbox
(seeSearch->Replace).

Default: no.
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ThesepreferencesparameterizetheCSSstylesheetusedto visualizethedocumentor to print it.

Settingsomeof thesepreferenceswill have no visible effect if the style sheetauthorhasspecifiedthe
correspondingpropertiesin thestylesheet.For example,if theuserpreferredbackgroundis specifiedin
theStylepaneasbeinglight yellow andif thestylesheetauthorhasspecifiedtherootelementbackground-
colorasbeingwhite, thedocumentwill berenderedwith a whitebackground.

Serif font family Specifiesthefont family usedfor propertyvaluefont-family:serif.

Default: Serif (theJavadefault serif font family).

SansSeriffont family Specifiesthefont family usedfor propertyvaluefont-family:sans-serif.

Default: SansSerif(theJavadefault sans-seriffont family).

Monospacedfont family Specifiesthefont family usedfor propertyvaluefont-family:monospace.

Default: Monospaced(theJavadefaultmonospacedfont family).

Default font family Specifiesthedefault valuefor propertyfont-family.

Default: SansSerif.

Default font size Specifiesthedefaultvaluefor propertyfont-size.

Default: 12pt.
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Default background Specifiesthedefault valuefor propertybackground-color.

Default: white.

Default text color Specifiesthedefault valuefor propertycolor.

Default: black.
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5.5 Options->Non-XMLFormats

5.5.1 Using XXE to edit non-XML structur ed formats

XXE canbeusedto editnon-XML structuredformatslikeHTML, Javadoc(TM)comments,APT,/etc/passwd,
/etc/printcap, http.conf (theApacheconfigurationfile), etc,if plug-insareprovidedfor suchstruc-
turedformats.

A formatplug-inworksby convertingthedataon thefly from thenon-XML formatto XML whenloading
a documentandby convertingthembackto thenon-XML formateachtime thedocumentis saved.

XXE relieson thefile nameextensionto find out whichplug-in is neededto loada document.Documents
whosefile nameextensionhasnot beenassociatedwith any format plug-in are loadedasXML (unless
downloadedfrom ahttpserverwhich returnstheMIME typeof thedocument).

XXE is bundledwith two formatplug-ins: onefor Javadocandonefor APT. Seebelow for a description
of theseplug-ins.

5.5.2 Registeringa format plug-in with XXE

Beforebeingableto load a non-XML documentinto XXE, the userneedsto registerthe corresponding
plug-in with theapplication.

Theformatplug-insbundledwith XXE areautomaticallyregisteredthefirst time theuserstartsXXE. You
mayneedto manuallyregistertheseplug-insbeforebeingableto usethemif youhaveanexistingXXE user
preferencefile (for exampleif you have upgradedyour XXE distribution). TheXXE userpreferencefile
is storedin file ~/.xxe underUnix andin file C:\winnt\Profiles\<user>\xxe.ini underWindows
NT.

Procedure:

1. Exit from XXE.

2. A formatplug-in is containedin oneor several.jar files. Copy these.jar files in a placewhere
theJava runtimecanfind andloadthem(i.e. “put themin theJavaCLASSPATH”).

3. RestartXXE.

Thesefirst3 stepsare notneededfor thebundledplug-ins.

4. UsemenucommandOptions->Non-XMLFormats.A dialogbox is displayed:
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Thedialog boxusedto registera formatplug-inwith XXE

5. Click on theAdd button. An input dialogbox is displayedrequestingyou to enterthenameof the
formatplug-in.

6. Entertheformatplug-in nameexactlyasspecifiedin its documentation.
Example:com.xmlmind.javadocformat.Format for theJavadocplug-in.

7. Click in the list on the format plug-in nameto display information about it. If the plug-in has
parameters,theConfigurebuttonis enabled,otherwisethisbuttonis “grayed”.

8. If possible,click on the Configure button to set the parametersof the plug-in. A dialog box is
displayed:
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Thedialog boxusedto configurea formatplug-in

Notethattheplug-in parametersaredocumentedin this dialogbox.
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5.5.3 The Javadocplug-in

A Javafile asdisplayedbyXXE

Thisplug-in addsJavadoc(TM)supportto XXE.

It mustberegisteredascom.xmlmind.javadocformat.Format.

Theintendedaudiencefor thisplug-in is JavaprogrammersandJavadocwriters.With XXE andthis plug-
in, it becomespossibleto edit theJavadoccommentscontainedin a Java file usinga word processor-like
view. Writing Javadocthis way is lesstedious(no manualformattingof commentlines)andis no longer
error-prone(DTD-directedediting).

Thisplug-in hasfull supportfor all Javadoc1.3 tagsplusmostof HTML 3.2tags.
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Thefollowing HTML 3.2tagsandattributesarenot supported:

� html,

� head,isindex, base,title, meta,link, script,style,

� body,

� object,applet,param,

� menu,dir,

� map,area,img usemapandismapattributes,

� form, input,select,option,textarea,

� xmp, listing, plaintext.

TheJavadoc1.3 tagsaremodeledin XML asfollows:

+attribute label

+attribute label

java

#PCDATA

formfeed

doc

description

link

author

version

param

paramname

paramdesc

return

exception

exceptionname

exceptiondesc

see

seeref

seehref

since

serial

serialdata

serialfield

fieldname

fielddesc

deprecated

fieldtype

any HTML inline or block +link

any HTML inline or block +link

any HTML inline or block +link

any HTML inline or block +link

any HTML inline or block +link

any HTML inline or block +link

any HTML inline or block +link

any HTML inline or block +link

any HTML inline or block +link

any HTML inline or block +link

#PCDATA

#PCDATA

#PCDATA

#PCDATA

#PCDATA

#PCDATA

same content and attributes as HTML <a>

#PCDATA

@see package.class#member ?label?

@see "string"

@see <a href="URL#value">label</a>

The description before the Javadoc tags

@author text

@version text

@param name text

@return text

@exception or @throws name text

@since text

{@link package.class#member ?label?}

@deprecated text

@serialField name type text

@serialData text

@serial text

Ctrl−L inserted in source code

Java source code

Javadoc comment block /** */

any HTML inline or block +link

1

1

1

1

1

1

1

1

N

N

N

N

N

N

N

N

N

N

N

N

N

N

N

N

N
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Thefile nameextensionrequiredfor a “Javadocdocument”is .java.

Unlike Web browsers,this plug-in is not designedto load brokenHTML 3.2. However, this plug-in can
help Javadocwriters to easilyspotandfix the HTML errorscontainedin Javadoccomments.Seenext
sectionfor a realworld casestudy.

theJavadocplug-in refusesto loadSun’sString.javafor theabovereason

WhenXXE refusesto loada Javafile, anerrordialogis displayedwith

� anerrormessage(notalwayseasyto understanddueto thelayeredarchitecture),

� theline numberof thestart of theJavadoccommentblock wheretheerroroccurred,

� acolumnnumberalwaysequalto 1.

Try to guesswhat the error messagemeansand fix the problem using your favorite text editor (use
xmleditor-support@xmlmind.comif youarereallystuck),thenreloadtheJava file into XXE.

Warning: beforeusingthis plug-in for thefirst time,pleasetake thetime to configureit properlyto make
surethatits newline andtabpoliciesarecompatiblewith yours.

Applying the Javadocplug-in to SunJDK 1.3.1sources TheJavadocplug-inhasbeentestedonall the
Java sourcesgivenby Sunfor theLinux JDK 1.3.1.

The plug-in hassucceededto load 1750out of 1877Java files. It hasfailed 127 timesgenerallyfor the
following reasons:

� TheJavadocwriter adds<code></code> tagsat placeswhereplain text (#PCDATA) is expected.

Example:puttingthenameof a@param between<code></code>.

Notethatit is not usefulto do sobecauseJavadocautomaticallyaddsa sensiblestyleto this kind of
plain text.

This is the most importantdiscrepancy betweenthe Javadocplug-in andJavadoc: Javadocintel-
ligently discards<code></code>, while the Javadocplug-in stubbornlyrefusesto load the Java
file.

� Typossuchas:

– typosin tagnames(examples:blockquoute, coder)

– forgetting’>’ at theendof startor endtags
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– unknown characterentities(example:&le;)

– puttinga spacebetweentheattributename,the’=’ signandtheattributevalue

– usingendtags(example:</p>) insteadof starttags

– duplicatingattributes(example:align)

� TheJavadocwriter sometimesforgetswhathehaslearnedaboutHTML.

Example1: puttingplaintext or inlineelementssuchas<code></code> directlyintoablockquote.

Example2: puttingapre blockbetween<code></code>.

� ’>’, ’<’, ’&’ not properlyescaped.Here,the plug-in tries to do its bestbut sometimesit misses
someof thesespecialcharacters.

Notethatall theerrorsdescribedaboveareimpossibleto do if XXE is usedto edit theJavadoccomments.

Having succeededto loadaJava file into XXE doesnot meanthatthisfile is valid: 45out the1750loaded
fileswerefoundhaving validity problems.

Generallythesevalidity problemsareminorandarecausedby missingattributesor invalid attributevalues.
It is possibleto quickly fix themby usingmenucommandTools->CheckValidity.

5.5.4 The APT plug-in

Thisplug-in addsAPT (Almost PlainText) formatsupportto XXE.

It mustberegisteredascom.xmlmind.aptformat.APTFormat.

APT is a text format for technicalarticleswhich is simple,structured,tag-less,andwhich is convertible
to HTML, XHTML, PDF, RTF, PostScript,SGML or XML DocBookusingthe OpenSourcetool called
aptconvert.Aptconvertcanbedownloadedfrom http://www.pixware.fr/.

Thefile nameextensionrequiredfor anAPT documentis .apt or .txt.
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6 APPENDIX A: CSS2propertiesand valuessupportedby XXE

6.1 Restrictions

The following propertiescan be inheritedwhetherexplicitly (inherit keyword) or implicitly (inherited
property).

For all propertiesexceptline-heightwherethespecifiednumberis inherited(whichis thecorrectbehavior),
theinheritedvalueis theactualvaluenot thecomputedvalue.
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Property Value Restrictions
background-color color|transparent

|inherit
-

border width [stylecolor?]?
|inherit

Orderis strictly width,
style,color

border-color side_value{1,4} -
border-bottom-color color|transparent

inherit
-

border-left-color " -
border-right-color " -
border-top-color " -
border-style none|dotted|dashed

|solid|double|groove
|ridge|inset|outset

No hidden

border-width thin|thick|medium
|length|inherit

-

color color|inherit -
font [styleweight?]?

sizefamily
|inherit

Orderis strictly style
thenweight

font-family [[name|generic] ,]* name|generic>name|generic

|inherit

Anythingotherthanserif
sans-serif,monospaceis
ignored

font-size medium|small|large
|x-small|x-large
|xx-small|xx-large
|smaller|larger
|length|percentage
|inherit

-

font-style normal|italic|oblique
|inherit

italic andobliqueare
aliases

font-weight normal|bold|inherit No N00,bolder, lighter
line-height normal|number|inherit No length, percentage
margin side_value{1,4} -
margin-bottom length|auto|inherit No percentage
margin-left " -
margin-right " -
margin-top " -
padding side_value{1,4} -
padding-bottom length|inherit No percentage
padding-left " -
padding-right " -
padding-top " -
text-align left|right|center

|inherit
No justify

text-decoration none|underline|overline
|line-through|inherit

No blink

text-indent length|inherit No percentage
vertical-align baseline|middle|sub

|super|text-top|top
|text-bottom|bottom
|inherit

No length, percentage

white-space normal|pre|nowrap
|inherit

-
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Thefollowing propertiescannotbeinheritedwhetherexplicitly (inherit keyword) or implicitly (inherited
property).

Property Value Restrictions
border-spacing lengthlength? -
content string|uri|attr(X)

|open-quote|close-quote
|no-open-quote
|no-close-quote
|counter(name)
|counter(name, style)
|counters(name, separ)
|counters(name, separ,

style)
|disc|circle|square
|seeextensions

Open-quoteis char. "‘",
close-quoteis char. "’",
no-*-quoteis ignored
Seerestrictions
aboutcounters
Counterstylesare
limited to: decimal,
lower-alpha,lower-latin,
upper-alpha,upper-latin,
lower-roman,upper-roman

display none|inline|block
|marker|table
|inline-table
|table-row-group
|table-header-group
|table-footer-group
|table-row
|table-column-group
|table-column|table-cell
|table-caption
|inline-block|tree

No list-item(usemarkers),
run-in,compact

height length|auto No percentage
marker-offset length|auto No percentage
width length|auto No percentage

� The CSS box decorations(border, padding, etc) are not supportedfor inlined elements. The
background-color is theonly propertysupportedfor suchelements.

� The borderproperties,exceptborder-color, cannotbe specifiedindividually for eachsideof the
box.

� counter-reset, counter-incrementpropertiesareignored.counter andcountersaresupportedin-
sidethecontentpropertybut with differentsemantics:thenameof thecounteris usedto specifythe
non-formattedvalueof thecounter.

Example1 (XHTML):

ol > li:before {
display: marker;
content: counter(n, decimal);
font-weight: bold;

}

In the previousexample,the counternameis n (singleletter ’n’, any letter is OK) which specifies
thatthecountervalueis therankof li within its parentelement(anol).

Example2 (DocBook):

sect3 > title:before {
content: counter(nnn-) " ";

}
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In thepreviousexample,thecounternameis nnn- (3 lettersfollowedby adash)whichspecifiesthat
thecountersegmentedvaluemustbebuilt asfollows:

1. Skip (dashmeansskip) therankof title within its parentelement(asect3).

2. Prepend(any lettermeansuse)therankof title parent(asect3) within its parent(asect2).

3. Prependtherankof title grand-parent(asect2) within its parent(asect1).

4. Prependtherankof title grand-grand-parent(a sect1) within its parent(anarticle or a
chapter).

� Thestyleof anelementmaybespecifiedusingaselectorcontainingthe:first-child pseudo-classbut
thestyleof suchelementis not recomputedwhensibling elementsareinsertedor deleted.

The workaroundis to manually“refresh” the view of the parentof suchelementusingthe Ctrl-L
keyboardshortcut.

� The!important specifieris ignored.

6.2 Extensions

� Two propertiescolumn-spanandrow-spanhave beenaddedto specifythe columnandrow span
of elementswith a table-cell display. The valuefor thesepropertiesis a strictly positive integer
number. Theinitial valueis 1. Thesepropertiesarenot inherited.

� eval(value, ..., value) may be usedto specifya dynamicallyevaluatedpropertyvalueanywherea
staticpropertyvalueis allowed.

A dynamicpropertyvalueis evaluatedjust beforebuilding theview correspondingto thesubjectof
theselector:

1. Thevalueargumentsareconvertedto stringsandconcatenatedtogether.

2. The resultingstringexpressionis passedto a script languageinterpreterwhich evaluatesit in
thecontext of thesubjectof theselector.

3. Theresultof theevaluationis a stringwhich is parsedasapropertyvalue.

XXE M1.3 hasno built-in script languageinterpreteryet but even without, saya JavaScriptinter-
preter, thisfeatureis usefulbecauseit allowsto useattr () propertyvaluesoutsidecontentproperties.

Example,XHTML th andtd table-cell formattingheavily relieson this feature:

td, th {
display: table-cell;
text-align: eval(attr(align));
vertical-align: eval(attr(valign));
row-span: eval(attr(rowspan));
column-span: eval(attr(colspan));
border: 1 inset gray;
padding: 2;

}

Whena script languageinterpreterwill be integratedin XXE (expectedin M2), this featurewill
allow the editor to fully supportDocBookandXHTML tablesby extractingcell propertyvalues
from tablemeta-informationtagssuchascolspec,spanspec,colgroup,column,etc.

� display: inline-block maybe usedto specifya rectangularblock thatparticipatesin an inline for-
mattingcontext. (This is similar to inline-table.)
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� display: tr eemaybeusedto mix styledelementviewsandnon-styled(tree-like)elementviews.This
is particularlyusefulfor meta-information(suchasDocBook’sbookinfo,sectioninfo,indexterm,etc)
for which asensiblestyleis hardto comeupwith.

Example(DocBook):

� In additionto whatis specifiedby CSS2,the:beforeand:after pseudo-elementsallow valuesof the
display propertyasfollows:

– If the subjectof the selectoris a table element,allowed valuesarenone, block, table-row-
group and table-row. If the valueof display hasany othervalue, the pseudo-elementwill
behaveasif thevaluewasblock.

– If thesubjectof theselectoris a table-row-groupelement,allowedvaluesarenoneandtable-
row. If thevalueof display hasany othervalue,thepseudo-elementwill behaveasif thevalue
wastable-row.

– If thesubjectof theselectoris a table-row element,allowedvaluesarenoneandtable-cell. If
the valueof display hasany othervalue,the pseudo-elementwill behave asif the valuewas
table-cell.

Theseextensionsaresupportedto addgeneratedcolumnandrow headersto arbitraryXML data
displayedasa table.

For example,with thesestyles,theselect,optgroupandoptionXHTML elementsaredisplayedasa
tablewith automaticallygeneratedcolumnandrow headers:
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select {
display: table;
border: 1 solid black;
padding: 2;
border-spacing: 2;
background-color: silver;

}
select:before {

content: row(cell("Category", width, 20ex), cell("Choice #1"),
cell("Choice #2"), cell("Choice #3"),
font-weight, bold, color, olive,
padding-top, 2, padding-right, 2,
padding-bottom, 2, padding-left, 2,
border-width, 1, border-style, solid);

display: table-row-group;
}
optgroup {

display: table-row;
}
optgroup:before {

content: attr(label);
}
option {

display: table-cell;
border: 1 solid black;
padding: 2;
background-color: white;

}

XHTML source:

<p><select>
<optgroup label="Language">
<option>Java</option>
<option>C++</option>
<option>Perl</option>
</optgroup>
<optgroup label="Editor">
<option>Emacs</option>
<option>Vi</option>
<option>UltraEdit</option>
</optgroup>
<optgroup label="OS">
<option>Linux</option>
<option>Windows</option>
<option>Solaris</option>
</optgroup>
</select></p>

Renderedas:
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� content maybe usedfor any elementandnot only for :before and:after pseudo-elements.When
usedfor anactualelement,it replaceswhatis normallydisplayedfor thiselement.

� contentmaycontainicon(name).

Namemustbeoneof thefollowing identifiers:disc,circle,square,diamond, invisible (1x1 trans-
parent image),right-tar get,left-tar get,filled-square,hollow-diamond, left-half-disc, right-half-
disc,up, down, left, right, pop-up, pop-down, pop-left, pop-right, left-link, right-link .

� contentmaycontainimage(source, width,height, smooth|default).

source Mandatory.
URL or pathof an imagefile. Only GIF, JPEG,PNGfiles will bedisplayedby XXE but this
mustnotpreventyou from usingotherformatsif yourbackendprocessorsupportsthem.
A relative URL or pathis relative to the locationof thedocumentbeingeditedandnot to the
currentworking directory.

width, height Optional.
Dimensionof theimagein pixels.A lengthmayoptionallybefollowedby astandardCSSunit
suchaspx, in, cm, mm, pt, pc, em,ex.
A negativelengthis interpretedasamaximumsize.This is usefulto displayimagesasthumb-
nails.
Useattr(name) to getthedesireddimensionfrom thevalueof attributenamedname.

smooth|default Optional.
The nameof the algorithmusedto changethe imagesize: smooth meanshigh-quality/slow
anddefault meanslow-quality/fast.

Example(XHTML):

img {
content: image(attr(src), attr(width), attr(height));

}

� contentmaycontainparagraph(content, ...,content). Thisconstructis usedto forcethecreationof
ananonymousparagraphwherethegenerated/replacedcontentis added.

Example1, this contentwill not wrapat word boundariesevenif thewhite-spacepropertyspecifies
to do so:

content: "Very long line of generated/replaced text content \
that will *not* wrap.";

white-space: normal;

Example2, this contentwill wrapat wordboundaries:

content: paragraph("Very long line of generated/replaced text content \
that will wrap because the paragraph construct is used.");

white-space: normal;

Thisconstructis alsousefulto specifycomplex generated/replacedcell content.Seebelow.



XMLmindXML Editor M1.3User’sGuide 63

� contentmaycontainrows(row_spec, ...,row_spec, ...),row(cell_spec, ...,cell_spec, ....),orcell(cell_content,
...). Theseconstructsareusedto specifytabular content.

Syntax:

– rows_spec= rows(row_spec,..., row_spec,prop_name,prop_value,....,prop_name,prop_value)

– row_spec= row(cell_spec,..., cell_spec,prop_name,prop_value,....,prop_name,prop_value)

– cell_spec= cell(cell_content,prop_name,prop_value,....,prop_name,prop_value)

– cell_content= string|attr (name)|paragraph(content,..., content)

Example:

content: row(cell("Category", width, 20ex), cell("Choice #1"),
cell("Choice #2"), cell("Choice #3"),
font-weight, bold, color, olive,
padding-top, 2, padding-right, 2,
padding-bottom, 2, padding-left, 2,
border-width, 1, border-style, solid);

prop_name,prop_valuepairsmaybeusedto specifythepropertiesof a cell. Specifyingsuchpairs
at therow level is equivalentto specifyingthemfor eachcell containedin therow. Specifyingsuch
pairsat therows level allowsevenmorefactoring.

Notethatshorthandpropertiescannotbeusedthere.Example:padding-top, padding-left, padding-
bottom, padding-right mustbeusedratherthanthesingleshorthandpropertypadding.

� contentmaycontaincomponent(className, param,..., param).

classNameis thenameof aJava classwhich implementstheinterface
com.xmlmind.xmledit.styledview.ComponentFactory.

com.xmlmind.xmledit.styledview.AttrCheckBoxFactory is for now the only classthat implements
this interface.This classcanbeusedto embeda booleanattributeeditorin thestyledview.

Example(APT):

verbatim:after {
content: component("com.xmlmind.xmledit.css.AttrCheckBoxFactory",

box, no, yes);
display: block;
color: olive;
font: .83em sans-serif;
text-align: center;
margin-left: auto;
margin-right: auto;

}

which is renderedas:

Embedded boolean attribute editor
used to edit the box attribute of the
<verbatim> element

Element <verbatim>
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7 APPENDIX B: Whitespaceprocessing

Whitespaceprocessingis performedonceat documentloadtime:

� A Mac or DOSline break(’\r’ or "\r\n") is normalizedto a singlenewline character(’\n’).

� If anelementhasthexml:space attributesetto preserve, all thewhitespacecharactersit contains
arepreserved.

Note that unlike otherattributes,the xml:space andxml:lang attributesof an elementmay be
“inherited” from anancestorelement.

� Otherwise,thedefaultbehavior of XXE is to replaceconsecutivewhitespacecharacters(’ ’, ’\t’, ’\n’,
’\r’) by asinglespacecharacter(’ ’).

� If a documenthasa DTD and if a mix element(an elementdescribedin the DTD asbeing able
to containtext interspersedwith child elements)is containedin a structure element(an element
describedin theDTD asonly containingchild elements),thespacecharactersat thebeginningand
at theendof themix, if any, aretrimmed.

Thisbehavior appliesto:

– elementswith a mixedcontentmodel,

– elementswith ANY astheir contentmodel,

– elementswhich arereferencedbut not declaredin theDTD.

� If a documenthasno DTD andif the “guesswhat spacesarenot useful” option hasbeenchecked
in theOptionsdialogbox(seeOptions->Options),whitespacecharactersaretrimmedfrom elements
containingchild elementsseparatedby whitespace.

Thexml:spaceattributeis very importantfor XXE becauseit is theonly way to skip thecompressionand
trimming of whitespacecharacters.Do not forget to add supportfor this standard XML attribute to the
DTDsyou’ll define.
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8 APPENDIX C: Keyboardshortcuts

Keyboardshortcutsinvokingmenucommands(ex. Ctrl-X thatinvokesEdit->Cut)arenot listedhere.

Mouseclick Description
Press-1 movecaretandbegin text selection;

If thereis no text closeto thearea
clickedupon,selecttheelementor
#PCDATA foundthere

Drag-1 extendtext selection
Release-1 endtext selection
Shift-click-1 extendtext selectionto themouseclick location
Ctrl-click-1 selectelementor #PCDATA clickedupon
Double-click-1 selectword (1)
Triple-click-1 selectthewhole#PCDATA
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Keystroke Description
Up movecaretto previousline (2)
Shift-Up extendtext selectionto previousline
Ctrl-Up selectenclosing#PCDATA if any; selectparent

elementotherwise
Ctrl-Shift-Up selectthepreceedingsibling of the

selectedelement
Down movecaretto next line
Shift-Down extendtext selectionto next line
Ctrl-Down selectpreviouslyselectedchild elementif

any;
if no child elementwaspreviouslyselected,
selectfirst child if any;
cancelelementselectionotherwise

Ctrl-Shift-Down selectthefollowing sibling of the
selectedelement

Left movecaretto previouschar.
Shift-Left extendtext selectionto previouschar.
Ctrl-Left movecaretto previousword
Ctrl-Shift-Left extendtext selectionto previousword
Right movecaretto next char.
Shift-Right extendtext selectionto next char.
Ctrl-Right movecaretto next word
Ctrl-Shift-Right extendtext selectionto next word
Tab inserta tabchar. if theview of thecurrentelement

acceptssuchchar. (ex. if thevalueof
white-spaceCSSpropertyis pre);
movecaretto next #PCDATA otherwise

Ctrl-Tab movecaretto next #PCDATA
Shift-Tab
Ctrl-Shift-Tab

movecaretto previous#PCDATA

Home movecaretto thebeginningof #PCDATA
Shift-Home extendtext selectionto beginningof #PCDATA
End movecaretto theendof #PCDATA
Shift-End extendtext selectionto theendof #PCDATA
BackSpace deletepreviouschar.
Delete deletenext char.
Escape canceltext or elementselection
Enter insertanewline char. if theview of thecurrent

elementacceptssuchchar. (ex. if thevalueof
white-spaceCSSpropertyis pre);
split theselectedelementin two parts
(if allowed)otherwise

Ctrl-Space insertanonbreakingspacechar. (&nbsp;)
Insert insertaftertheselectedelementanempty

#PCDATA (if allowed)
Shift-Insert insertbeforetheselectedelementanempty

#PCDATA (if allowed)
Ctrl-Insert insertaftertheselectedelementanelement

of thesametype(if allowed)
Ctrl-Shift-Insert insertbeforetheselectedelementanelement

of thesametype(if allowed)
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Notes:

1. OnMac,keyboardshortcutsusetheCommandkey ratherthantheControlkey.

2. Wordsaresimply sequencesof charactersseparatedby white spaces.

3. XXE hasno conceptof lines. For example,for XXE, the “previous line” is simply the view of a
#PCDATA which precedes(in theorderof thedocument)the#PCDATA containingthecaret.This
“previousline” view is chosento bethenearestoneabovetheview of the#PCDATA containingthe
caret.
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9 APPENDIX D: Enhancementsand bug fixes

9.1 M1.3 Patch 3 (August07,2002)

Bugfixes:

� Workarounda Java 1.4 bug relatedto menumnemonics.Example: saving a file with "Alt-F S"
insertedan"F" in thedocument.This bugdoesnot seemto happenwith Java1.3.1.

Enhancements:

� Slovak localizationby Zdenko Podobný.

� Germanlocalizationby VolkerHess.

9.2 M1.3 Patch 2 (May 22,2002)

M1.3 Patch2 hasbeenreleasedmainlybecauseour installerbuilt usingZeroGInstallAnywhere(anexcel-
lentproductthatwe recommend)seemednot to becompatiblewith Java 1.4.

While at it, we havealsoqualifiedXXE underJava 1.4.

Bugfixes:

� Plaintext "<em>word</em>" whencopiedto clipboard,waspastedasanem element.

Enhancements:

� Addedsupportfor NormanWalsh’sSlidesXML V2.0 DTD (a CSSstylesheetanda template).

� Split Brian Lalonde’s docbook41.cssin two parts: sdocbook.cssanddocbook.css(which imports
sdocbook.css).

Thismodularizationwasneededin orderto cleanlyimplementslides.css.

XMLmind’soriginaldocbook.css(i.e. pre-BrianLalonde’s)hasbeenremovedfrom thedistribution.

� OnMac,keyboardshortcutsusetheCommandkey ratherthantheControlkey. Therearestill sevear
problemsrelatedto mouseandkeyboard eventson theMac:

– Ctrl-Click-1 doesnot work.

– OnaFrenchkeyboard,typingCmd-ZsendsaCmd-Weventto XXE andCmd-QsendsaCmd-
A.

– TheswappedCmd-Z/Cmd-Wonly worksonetime.

� TheAZcheckspell-checkerenginebundledwith XXE hasbeenupgradedto its latestversion.

Thestatusof thedictionariesneededby AZcheckhasbeenclarified(seeWebsite).

9.3 M1.3 Patch 1 (Mar ch 13,2002)

Enhancements:

� Addedsupportfor thefollowing encodings(bothwhenloadingadocumentandwhensaving it -- see
updatedSave tabin Options->Optionsdialogbox):
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– Windows-1252(or Cp1252)WindowsLatin1,WestEurope.

– ISO-8859-15Latin9,updatesLatin1 with symbolssuch astheEuro.

– ISO-8859-2Latin2,CentralandEasternEurope.

– ISO-8859-3Latin3,Esperanto,Maltese,Turkish.

– ISO-8859-4Latin4,Estonian,Latvian,Lithuanian,Greenlandic,Lappish.

– ISO-8859-5Cyrillic.

– ISO-8859-7Greek.

– ISO-8859-9Latin5,Turkish.

– ISO-8859-13Latin7,Baltic.

Donotforgetto explicitly addthiskind of declaration<?xml version=’1.0’ encoding=’ISO-8859-15’?>

at the beginningof your documenttemplatesbecausesuchencodingscannotbe automaticallyde-
tected.

We’ve only testedISO-8859-15.If you have problemswith theothernewly supportedencodingsor
if youneedmoreencodings,tell us.

� XXE localizedto Spanishby JesusRedradoof UniversidaddeNavarra.

� docbook41.css enhancementsby BrianLalonde.

� Improvedthelook of theTools->CheckValidity non-modaldialogbox.

Bugfixes:

� In somecases,XXE usedthesameauto-generatedvaluefor ID attributesof newly createdelements.

9.4 M1.3 (February 6, 2002)

Milestone1.3.

Enhancements:

� Did averysimpleintegrationof abetaversionof AZcheck,anot-yet-releasedpureJavaspell-checker
product.

– TheEnglishdictionaryis theonly onebundledwith XXE, but severalotherdictionariescanbe
downloadedfrom thedownloadpageof XMLmind.
Downloadeddictionariesmustbecopiedto thedict subdirectoryof thedirectorycontaining
xxe.jar. Makesure thatdownloadeddictionariesare savedasfileswith extension.jar.

– Like for search/replaceandfor printing, it is possibleto checka subsetof the documentby
explicitly selectingtheelementto bechecked.
Like for search/replaceand for printing, restrictingthe commandto the text selectionis not
possible.

– Thekeyboardshortcutof Tools->CheckSpellingErrorsis Ctrl-Shift-S(S like Spell).

� AddedaSelectionmenuandcorrespondingbuttonsto thetool bar.

� AddedFile->New, File->Open,File->Save,Edit->Undo,Edit->Redobuttonsto thetool bar.

� Addedannew Edit->ApplyLastConversioncommandwhich is very handywhen,for example,you
wantto convertseveralpiecesof plain text to XHTML strongor em.

Its keyboardshortcutis Ctrl-A (A like Again). Previously, this wasthe keyboardshortcutof Edit-
>SelectAllbut this commandis not veryuseful.
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� Slightly improvedtheindentedoutputby addingsomeopenlinesat safeplaces.

� Addeda new option to theEdit tabof theOptionsdialogbox which couldbeusefulfor userswho
createtheirown DTDs. Thisoptionspecifieswhatto dowhenanewly createdelementis insertedin
thedocumentandwhenthecontentmodelfor this typeof elementhasseveralpossiblechoicesfor
thechild elements.

� A fairly completeDocBook style sheetnameddocbook41.css hasbeencontributed by Brian
Lalonde(Brian Lalonde’s email addresscanbe foundat the beginningof docbook41.css). This
stylesheetbecomesthedefaultonefor DocBook.

Thepreviousonenameddocbook.css, is still availablebut will no longerbemaintained.

If youwantto usethisnew stylesheet,edityourexistingDocBookdocumentswith a text editorand
replace:

<?xml-stylesheet type="text/css" href="../css/docbook.css" ?>

by:

<?xml-stylesheet type="text/css" href="../css/docbook41.css" ?>
<?xml-stylesheet type="text/css" alternate="yes" title="Previous docbook stylesheet"
href="../css/docbook.css" ?>

Of course,replace../css by theactualURL of thedirectorycontainingyourstylesheet.

Bugfixes:

� xxe.bat doesnot launchXXE if installedin a directorylike C:\Program Files\xxe, because
thedirectorynamecontainswhitespacecharacters.

� Thedetectionof thecharsetof a CSSstylesheetbasedon theBOM (ByteOrderMark) foundat the
beginningof thefile wasincorrect.

9.5 M1.2 Patch 5 (December19,2001)

Official supportfor MacOSX. However, for now, the MacOSX versionof XXE is lessusablethanthe
otherUnix andWindowsversionsfor thefollowing reasons:

� Javabug: whateverthepapersizetheuserchooses,themarginsandoverallsizeof theprintedoutput
areincorrect.

� Javabug: printingcannotbecanceled.

� Java bug: on a Frenchkeyboard,typing Ctrl-Z sendsa Ctrl-W event to XXE andCtrl-Q sendsa
Ctrl-A.

� Java bug: thestandardshortcutCommand-Qfoundon theMac menubardoesnot invoke thewin-
dowClosinghandlerregisteredby theapplication.Therefore,if a usertypesCommand-Qinsteadof
Ctrl-Q, thestateof XXE will not besavedin ~/.xxe.

� Mac specificity:evenwhenusinga multi-buttonmouse,clicking with theright buttonwill not pop-
up the contextual menu(suchasthe "ExpandAll/CollapseAll" menuof a treeview component).
TheusermustuseCommand-Clickinstead.

� Mac specificity: someMacs,suchasiBooks,have no InsertandDeletekeys, thereforesomeof the
mostusefulXXE shortcutsarenot available.
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Bugfix: if thestyleof thedocumentelement(thatis therootelement)dependsononeof its attributes,this
stylewasnotproperlyupdatedeachtime this attributewaschanged.

Enhancement:addedadefaultEncoding parameterto boththeAPT andJavadocformatplug-ins.This
parameterspecifiestheencodingto beusedwhenloadingandsaving afile if noencodinghasbeenspecified
by theconnection.This encodingmustbea Java encodingname(exampleISO8859_1) andnot a IANA
charsetname(exampleISO-8859-1).

9.6 M1.2 Patch 4 (November27,1001)

Bugfix: fixesabugrelatedto valid but “strangelywritten” elementcontentmodelsfoundin DTDssuchas
RSS0.91.This bug is describedbelow in subsectionOctober1, 2001.

Notethatevenwith this bugfix, XXE still doesn’t checkthevalidity of theDTD: DTD writersreallyneed
to checktheirDTDsusinga third partytool suchasJamesClark’sSP(in XML mode).

Usersthatjust write DocbookandXHTML documentsdon’t needto upgrade.

9.7 M1.2 Patch 3 (November23,2001)

Bug fix: in a CSS,a referenceto the attribute A of the elementwhich is the subjectof the selectoris
specifiedusingconstructattr (A).

CSSbeing caseinsensitive, all CSSidentifiersare convertedto lower-casecharacterstrings(exceptin
selectors).

Therefore,if you specify attribute nameA as an identifier, A is automaticallyconvertedto lower-case,
which maybeaproblembecauseXML is case-sensitive.

In orderto specifynon-lower-caseattributenames,onemustspecifyA asa quotedCSSstringratherthan
a CSSidentifier. Example:specifyattr("HRef") ratherthanattr(HRef).

Unfortunately, abug preventedXXE from acceptingconstructattr (string).

9.8 M1.2 Patch 2 (November7, 2001)

Workaroundabug which preventsIBM Java from displayingmenulabelsandotherresources.

9.9 M1.2 Patch 1 (October 25,2001)

Bugfixes:

� Dialogsappearedin iconicstatethesecondtimethey wereusedunderthecontrolof certainwindow
managerssuchaskwin, KDE2 window manager, andfvwm2. (No suchproblemunderWindowsor
whenusingkwm, KDE1 window manager, or mwm.)

We have found a workaroundfor theseJava(?)/window manager(?)bugs. Thingsarenot perfect
(thereare still focus, window location and window size problemsfor fvwm2) but at leastXXE
becomesusable.

� Thesearchfacility tendedto selectfoundtext from thebeginningof theelementto thebeginningof
thenext onewhich is not asconvenientasselectingfoundtext from thebeginningof theelementto
its end.

Bugworkarounds:
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� UnderWindows,multi-font text locationandsizeproblemswhetheron screenor whenprinting can
besolvedby switchingfrom Java genericfonts (Serif, SansSerif,Monospaced)to Windows native
TrueTypefonts(Arial, Verdana,etc).

Thiscanbedoneby usingtheStyletabof thenew Options->Optionsdialogbox.

9.10 M1.2 (October 19,2001)

Milestone1.2.

Thenew printing featurecontainedin this releaserequiresat leasta Java runtime1.3. Therefore,theJava
1 platformis no longersupported.Do not upgradeif youneedto keepworkingwith a Javaruntime1.1.

Enhancements:

� Addeda literal andregularexpressionsearchandreplacefacility.

� Thedocumentbeingeditedcannow beprinted. It is alsopossibleto just print theselectedelement
(for example:theselectedsection).

A @media print sectionhasbeenaddedto all theCSSstylesheetsbundledwith XXE to slightly
customizethemfor printing.

Note that this is just a quick anddirty printing facility: CSSconstructswhich arespecificto paged
media,suchas@page or page-break-before, areignored.High-qualityprintingcanbeachieved
by usingthird partyXSL tools.

� Usingthenew Optionsdialogbox, it is now possibleto specifytheuserpreferencesin termsof font
face,font size,text colorandbackgroundcolor.

Of course,thesepreferenceswill havenoeffectof thewordprocessor-likeview if thecorresponding
style propertieshave been“hardwired” into the CSSstyle sheet. (This is not the casewith all the
stylesheetsbundledwith XXE.)

� Edit->Join,theinversecommandof Edit->Split,concatenatestheselectedelementwith thepreceed-
ing one,if this preceedingelementis of thesametype.

� Selectinganelementautomaticallymovesthecaretinsideit, unlessthecaretis alreadyinsideoneof
thedescendantsof thiselement.

� Ctrl-Shift-Up arrow selectsthe preceedingsibling of the selectedelement.Ctrl-Shift-Down arrow
selectsthefollowing sibling of theselectedelement.

� Betteruserfeedbackduringlengthyoperationssuchasdocumentloadingor printing.

During certain“safe” steps,it is now possibleto canceltheselengthyoperationsby clicking on the
spinningbeachball icon or on thestatusmessagelocatedat thebottomof XXE mainwindow.

� Undoing/redoingan actionmovesthe caretinside the modifiedelement. If the modifiedelement
containsno text, it is selectedinstead.

� AddedcommandTools->RefreshSelectedElement(shortcutCtrl-L) thatrebuilds theview of these-
lectedelement.

� Thealgorithmusedto scaleimagescannow bespecifiedin thestylesheetby usingscaling, a new
optionalparameterof the image(source, width, height, scaling) construct.

Parameterscaling has two possiblevalues: smooth which meanshigh-quality/slow and default
whichmeanslow-quality/fast.

SeeAPPENDIXA: CSS2propertiesandvaluessupportedby XXE.
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Bugfixes:

� UsingTools->EditAttributesdisabled(without “grayingout” thetool bariconsor Edit menuentries)
mostediting commandsuntil you clicked elsewherein the documentview to changethe selected
element.

� Typedcharactersfrom range\u00A1to \u00A7(examples:£, §) wereignored.

� Imagesdisplayedasreplacedcontentfor someelementswerecached.If youchangedtheimagedata
without changingits file name(example: you updatescreencapture12.jpeg) andyou typedCtrl-L
(refreshselectedelement),theold imagewasstill displayed.

� Undoing/redoingattribute changesdidn’t properly move the caretwhen the caretwas inside the
elementbeingedited.

� Pastingsometext (or insertingatext file) containingcontrolcharacterscausedXXE to silentlycreate
anon-wellformedXML document.

� TheTools->CheckValidity window crashedafterthefollowingsequenceof actions:Tools->CheckValidity
displayssomevalidity errorsin its window, theseerrorsarefixedby theuser, Tools->CheckValidity
displaysa blankwindow, userusesEdit->Undoto revert to the invalid state,Tools->CheckValidity
is usedagainto redisplaythevalidity errors.

� An elementwith contentmodelANY cancontain#PCDATA or any declaredelementtype. Previ-
ously, this typeof elementwasnotallowedto contain#PCDATA.

� For consistency, elementtypesthathavenotbeendeclaredin theDTD (using<!ELEMENT>) refer-
encedin theDTD (for example,referencedin thecontentmodelof otherelementtypesor having an
<!ATTLIST> declaration)arenow treatedasfirst classelementtypes.

Thereforethetrimming of whitespacein a “mix” containedin a “structure”now appliesto:

– elementswith a mixedcontentmodel,

– elementswith ANY astheir contentmodel,

– elementswhich arereferencedbut not declaredin theDTD.

SeeAPPENDIXB: Whitespaceprocessing.

� In a CSSstylesheet,@page, @fontface and@media (otherthanthoseof typescreen or print)
werenotproperlyskipped.

� TheXHTML stylesheethasbeencleaned-upto only supportthexhtml1-strictDTD.

9.11 October 1, 2001

� Bugfix: importantperformanceproblemsrelatedto theinteractionbetweenthedocumentview and
thescroll bars.Theseperformanceproblemswerenot presentin Milestone1. Theseproblemsare
importantenoughto justify anupgradefrom theoriginalXXE M1.1.

� Bug fix: embeddedJava componentswere not properly moved in the documentview when the
documentis modifiedby theuser.

� Bugfix: in thenon-styled(tree)view, somebordersweredrawn with araisedrelief insteadof amuch
nicersunkenrelief.
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� Bugthatcannotbefixedwithouta major rewrite: someDTDssuchasRSS0.91arenotsupportedby
XXE becausethey containstrangelywritten,but valid, contentmodelsfor someelements.Example:

<!ELEMENT channel (title | description | link | language | item+ |
rating? | image? | textinput? | copyright? |
pubDate? | lastBuildDate? | docs? | managingEditor? |
webMaster? | skipHours? | skipDays?)*>

Theauthorof this DTD wantsin factto expressthefollowing contentmodel:

<!ELEMENT channel (title & description & link & language & item+ &
rating? & image? & textinput? & copyright? &
pubDate? & lastBuildDate? & docs? & managingEditor? &
webMaster? & skipHours? & skipDays?)>

wherenon-XML operator’&’ meansthattheparticlescanoccurin any order.

Theworkaroundis to rewrite thecontentmodelsthatarerejectedbyXXE. Whatfollowsisequivalent
in termsof validationto theexampleabove:

<!ELEMENT channel (title | description | link | language | item |
rating | image | textinput | copyright |
pubDate | lastBuildDate |docs | managingEditor |
webMaster | skipHours | skipDays)*>

9.12 September21,2001

Milestone1.1

� TheJavadocplug-in addsJavadoc(TM)supportto XXE. With XXE, you cannow edit theJavadoc
commentscontainedin a Java file usinga wordprocessor-likeview.

� Bug fix: undercertainconditions,whenloadinga documentwith a DTD, trimming thewhite space
of anelementwith mixedcontentresultedin uselessempty#PCDATA.

� Bug fix: moving the caretinto a newly createdcollapsedTreeView causedan ArrayIndexOutOf-
BoundsException.

� Bug fix: undercertainconditions,whenthe tagauto-completionfeaturewasused,the tag list con-
tainedin thetagchooserdialogbox wasnotproperlyscrolled.

� Thenew menucommandEdit->InsertFilemaybeusedto pastethecontentof a file (XML or plain
text) before,into or aftertheselectedelement.

If after parsingthe contentof the file andafter analyzingwhat canbe donein the context of the
selectedelement,XXE findsthatsuchinsertionis not allowed,XXE will simply beepto signalthat
thecommandhasnot beencompleted.

� Thecaretblinks whenthedocumentview hasthekeyboardfocus.

� Whenadocumentis scrolled,thecaretis movedsoasto try to keepit alwaysvisible.

� Whenyou switch from a stylesheetto another(or to No stylesheet)usingthe Stylemenu,all the
documentmarksarepreserved (caret,text selection,elementor #PCDATA selection).Previously,
thesemarkswerecleared.

� Whenthereis no ambiguity, typingEntersplitstheselectedelementin two parts.

Example:typing EnterwhenanXHTML p is theselectedelement,splits thep in two parts,while
typingEnterwhenanXHTML pre is theselectedelement,insertsa linefeedcharacterinto thepre.

The Edit->Split menucommand(shortcutCtrl-Enter) is still the standardway to split the selected
elementin two parts.
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� Thearrow buttonsof thescrollbarsnow scrollthedocumentview byareasonableamount.Previously
thescroll incrementwas1 pixel.

� The algorithmusedto scaleimageshasbeenchangedfrom high-quality/slow to low-quality/fast.
Thesizeof the “thumbnails”usedin all theCSSstylesheetsbundledwith XXE hasbeenchanged
from 200x200max. to 400x200max.

9.13 September7, 2001

� Bugfix: a build errormaypreventXXE from startingwhenusingSunJava 1.3.1.

� Whensaving a file as indentedXML, the indentationcanbe set to 0 to achieve a not uncommon
formattingstyle.Previously, theminimumvaluefor indentationwas1. (SeeOptionsdialogbox.)

� An elementdisplayedasa tree,displaysits attributes(if any) aswell asits child elements(if any).
Previously, theattributeswerenot displayed.

Notethattheattributesarestill not editablein thedocumentview: youmustusetheAttributeEditor
dialogbox.

AnAntExample:mostAntelementshavejust attributesandno child elements.

9.14 August17,2001

� Bug fix: the indentedXML file generatedfor a documentthatcontainsemptyelementswith a non-
emptycontentmodelwasnot well-formed.

9.15 August3, 2001

Milestone1.


